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         Twin Tec 
--TCFI Gen 7 & M8FI Racing EFI-- 

Startup Guide and System 
Installation 

 

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING. DESIGNED FOR 

RACING. NOT LEGAL FOR SALE OR USE IN CALIFORNIA OR ON POLLUTION CONTROLLED 

VEHICLES. 

OVERVIEW – CONCEPT 

Our Racing EFI system has been designed for offroad racing use in the “King of the Baggers” racing 

series. Each Racing ECU has been designed to plug directly into the factory HD harness. 

• 17800 - TCFI7 → 2014-2016 Twin Cam Ultra/Touring - Natural Aspiration Engines (Utilizes OE 1 Bar) 

• 17801 - TCFI7 → 2014-2016 Twin Cam Ultra/Touring - Turbo Engines (Utilizes DTT 2 Bar Sensor) 

• 17802 - TCFI7 → 2014-2016 Twin Cam Ultra/Touring - Turbo Engines (Includes DTT 3 Bar Sensor) 

• 17803 - TCFI7 → 2016-2017 Twin Cam Softail Models -NA Engines (Utilizes OE 1 Bar) 

• 17804 - TCFI7 → 2016-2017 Twin Cam Softail Models - Turbo Engines (Utilizes DTT 2 Bar Sensor) 

• 17805 - TCFI7 → 2016-2017 Twin Cam Softail Models - Turbo Engines (Includes DTT 3 Bar Sensor) 

• 17808 – M8FI → 2017-2020 M8 Ultra/Touring - Natural Aspiration Engines (Utilizes OE 1 Bar) 

• 17809 - M8FI → 2017-2020 M8 Ultra/Touring - Turbo Engines (Utilizes DTT 2 Bar Sensor) 

• 17810 - M8FI → 2017-2020 M8 Ultra/Touring - Turbo Engines (Includes DTT 3 Bar Sensor) 

• 17811 - M8FI → 2018-2020 M8 Softail Models - Natural Aspiration Engines (Utilizes OE 1 Bar) 

• 17812 - M8FI → 2018-2020 M8 Softail Models - Turbo Engines (Utilizes DTT 2 Bar Sensor) 

• 17813 - M8FI → 2018-2020 M8 Softail Models - Turbo Engines (Includes DTT 3 Bar Sensor) 

• 2021-2023 M8 ECU – Coming Soon 

→ M8FI and TFI7 require the use of version 20.4+ of the PC_LINK.exe tuning and version 19.91+ of the 

TCFI_LOG.exe logging software.  V20.4/19.91 has numerous updates including storing the options in the 

tune file and ecu.  

AUTO-TUNE is included in all of our EFI systems. 

To utilize AUTO-TUNE, the wideband O2 sensors must be installed in the exhaust AND closed loop 

must be enabled in the tune.  After the engine is warm and close loop becomes active, AUTO-TUNE 

learns fuel trim corrections.  To apply the fuel corrections to the tune, the uploaded from the ECU and 

applied to the tune (corrections adjust the main and front fuel tables). 

IMPORTANT NOTE: You must do some basic tuning before enabling the AUTO-TUNE feature. The 

tune on your motorcycle must be functioning at a basic level before using this feature.  It must start and 

run without popping and blowing black smoke.  Use the Real Time Data view and the build in data-

logging to monitor and adjust the tune. 

http://www.daytona-twintec.com/
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• Data Logging is automatically enabled – Anytime the engine is running, data is always recorded by 

the ECU in an endless loop, constantly overwriting the oldest data with the new data. Use the TCFI-M8 

Data Logging software to read back the data that is automatically stored in the ECU. 

• Tuning, monitoring and data log playback occurs via the USB Interface and the PC_LINK.exe tuning 

software or the TCFI_LOG.exe data log viewing software. The USB interface is the small black box; it 

connects between the USB port on your PC and the WEGO IIID (see the diagram labeled TCFI7 & M8FI 

EFI SYSTEM DIAGRAM). 

NOTE: Even if you do not utilize the wideband sensors – the WEGO IIID unit must 

be installed so your PC can communicate with TCFI7 & M8FI EFI systems through 

the USB Interface. 

The two plugs from the WEGO IIID module must also be connected on the right-hand side of the bike. 

These two connections allow the ECU to communicate with other modules on the motorcycle (Body 

Control Module & Speedometer). Note: The two connectors are grey and black on the Ultra/Touring 

Models, and both connectors are black on the Softail Models. 

All codes will be read/cleared using the TCFI-M8 Datalogging software:  TCFI_Log.exe. 

Note: For short term testing, the wideband sensors do not need to be connected.  They should be 

connected so you can see what the engine is doing and how it is responding to your tuning changes. 

Download Software and device Drivers  

   

◼ PC_LINK_TCFI.exe -- PC Software that is used to tune the ECU. This software is also used to    

program the VIN, Odometer and Auto-Calibrate the ETC System. When using the Auto-Tune feature – this 

software is used to read the learning out of the ECU and apply it to the fuel tables. 

◼ TCFI_LOG.exe is the PC Software is used to view/clear codes, view live data as the engine is running 

or read and view data log files out of the ECU. 

◼ Find the latest software at:  daytona-twintec.com/software 

◼ Run the installer: https://jmschip.com/content/DTT/Software/TCFI_Software_Installer.exe 

◼ Run the update: https://jmschip.com/content/DTT/Software/M8FI-TCFI7_SelfInstallUpdate_204-

1991__041024.exe 

 

 

CAUTION: Tuning the M8FI or TCFI requires competency in PC operation, using Microsoft 

Windows based programs, and basic engine tuning and fuel injection mapping concepts. The 

PC Link software requires that are familiar with the Harley-Davidson fuel injection system 

and that you have access to basic test equipment and factory service manuals. 
 

 

 

http://www.daytona-twintec.com/
https://jmschip.com/content/DTT/Software/TCFI_Software_Installer.exe
https://jmschip.com/content/DTT/Software/M8FI-TCFI7_SelfInstallUpdate_204-1991__041024.exe
https://jmschip.com/content/DTT/Software/M8FI-TCFI7_SelfInstallUpdate_204-1991__041024.exe
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THE EFI KIT 

 

The M8FI & TCFI Gen 7 kits include the ECU, WEGO IIID dual channel wide-band exhaust gas oxygen 

sensor interface, 2 Bosch LSU 4.2 oxygen sensors and USB interface. 

 

ECU, USB Interface, WEGO III Wideband, Wideband Sensors 

 

 
 

 
 

 

http://www.daytona-twintec.com/
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TCFI7 & M8FI EFI SYSTEM DIAGRAM 

 
 

 

 

 

M8FI - TCFI GEN 7 PRE-INSTALLATION CHECKS 

 
Make sure that the original equipment (OE) engine control module (ECM) is functioning correctly (other 

than tuning issues) before attempting TCFI installation. If the OE ECM is setting diagnostic codes, find 

and correct any underlying problems first. 

GENERAL RECOMMENDATIONS 
 

The M8FI - TCFI system has been designed to be used with the H-D OE coil. Fuel injected engines 

require a special coil with low primary resistance and an additional terminal for ion-sensing. Do not 

attempt to use any aftermarket coil not specifically intended for fuel injection applications with ion-

sensing ignition. 

Due to the short lengths involved on motorcycle applications, energy losses in spark plug wires are 

insignificant. OE carbon core suppression cables will deteriorate after several years. For a more durable 

replacement, we suggest spiral core type spark plug cables.   

 

CAUTION: Do not use solid copper spark plug cables or non-resistor type spark plugs. The 

M8FI/TCFI unit may misfire. Aftermarket spark plug wires with excessive internal resistance have a 

tendency to malfunction. 

 

 

http://www.daytona-twintec.com/
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TCFI GEN 7/M8FI INSTALLATION 
 

1. If motorcycle is equipped with security system, make sure system is disarmed. Turn off the ignition 

switch and disconnect the battery ground cable before proceeding. 

2. Find and remove the OE ECM. The OE module is usually located under the seat or under a side cover.   

3. Install the TCFI module. The figure below shows a typical installation.  

 

TYPICAL INSTALL TCFI7 & M8FI → 2014-2020 Ultra / Touring 

 

 

 

 

 

 

 

http://www.daytona-twintec.com/
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TCFI7 & M8FI INSTALL TYPICAL → 2016-2020 Softail  

 

    

4. Do not reconnect the battery ground cable until you have completed installation of the WEGO 

IIID.  Do not attempt to start the engine until you have completed the initial setup.   

 

WEGO IIID INSTALLATION OVERVIEW 
 

The dual channel WEGO IIID allows simultaneous front and rear cylinder fuel auto-tuning during actual 

riding conditions. The terms TCFI and WEGO are used throughout this document as generic terms 

and refer to the various TCFI Gen 7/M8 and WEGO IIID units unless otherwise noted. 

The WEGO system uses Bosch LSU 4.2 5-wire wide-band oxygen sensors. By utilizing miniature surface 

mount electronics technology, digital signal processing techniques, and a switching power supply for the 

sensor heater, the WEGO provides the same level of accuracy as lab systems.  

The WEGO unit has dual 0-5 volt analog air/fuel ratio (AFR) outputs that are connected to the TCFI for 

closed loop AFR control. The WEGO IIID version included in the TCFI Gen 7 kit has a special wire 

harness that also provides proper connections for the four terminal data link connector used for 

communications between the TCFI module and our USB interface.  

      

REPLACEMENT SENSORS AND ACCESSORIES 
 

The WEGO uses standard Bosch LSU 4.2 sensors used on a VW production application (Bosch P/N 0 

258 007 057/058 or VW P/N 021 906 262B). The proprietary VW connector is replaced with a smaller 

Deutsch DT-04-6P. We offer replacement sensors with the Deutsch connector installed. 

http://www.daytona-twintec.com/
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WEGO IIID INSTALLATION 
 

 

1. If motorcycle is equipped with security system, make sure system is disarmed. Turn off the ignition 

switch and disconnect the battery ground cable before proceeding. 

2. In general, the sensors should be mounted 2-8 inches from the head flange. Available clearance will 

usually dictate the optimum location. When choosing a mounting location, allow several inches 

clearance for the sensor wire harness. The wire harness must exit straight out from the sensor. Do not 

loop the harness back onto the sensor body.  

3. You cannot use the original equipment (OE) 12 x 1.25 mm oxygen sensor mounting bosses. Remove 

the OE oxygen sensors and use the supplied 12 x 1.25 mm hex socket plugs to block off their 

mounting bosses after completing step 4. 

4. 18 x 1.5 mm weld nuts must be welded onto the exhaust pipes and can be located near the smaller OE 

oxygen sensor mounting bosses. After welding, run an 18 x 1.5 mm tap through the threads. Failure to 

clean the threads may result in sensor damage.  

5. Do not install the new Bosch sensors until after the free air calibration procedure described in the 

following section. Always use an anti-seize lubricant such as Permatex 133A on the sensor threads.  

6. Install the WEGO unit. Suggested placement - image below. 

 

ULTRA/TOURING – ECU/WEGO Placement (left) -- Front/Rear O2 connectors (right) 

                 

                 

 

 

 

http://www.daytona-twintec.com/
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ULTRA/TOURING – Wideband O2 Placement 

    Typical Front Sensor Installation                              Typical Rear Sensor Installation 

 

         

 

7. Connect the Bosch sensors to the 6 pin mating connectors on the WEGO wire harness. The longer 

cable (with yellow band) is for sensor 1 (front).  For additional protection and improved cosmetics, 

use Techflex 1-1/4” Black Flexo Clean Cut FR expandable sleeving over the connectors (available 

from www.wirecare.com).   

 

SOFTAIL → WEGOIII Connection to Rear O2 (left) & Front O2 (right - below) 

 

   

http://www.daytona-twintec.com/
http://www.wirecare.com/
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SOFTAIL Turbo → Wideband Front O2 Sensor Placement (left) -- Rear O2 (right) 

 

                         

8. Connect the WEGO wire harness to the front and rear oxygen sensor and data link connectors on the 

OE wire harness.  

9. Connect the black WEGO ground wire to an existing frame ground connection point near the ECM. 

10.  Reconnect the battery ground cable. Do not attempt to start the engine until you have 

completed the free air calibration of the WEGO and initial setup of the TCFI.  

 

WEGO IIID Controller – Connect to USB,  

     Communicate with the ECU                                              BENCH FLASH SETUP  
 

                                 

http://www.daytona-twintec.com/
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WEGO IIID OPERATION 

 

The WEGO has red status LEDs for each channel. When power is turned on, the LEDs blink at a slow 

rate until the corresponding sensor has reached normal operating temperature. 

After installation, the WEGO system requires free air calibration. This should be done with the sensors 

dangling in free air. The environment must be free of hydrocarbon vapors. We suggest that you perform 

the free air calibration outdoors. Turn the free air calibration trimpots on the WEGO full 

counterclockwise. Turn on power and wait for 60 seconds so the system can fully stabilize. Then slowly 

turn each free air calibration trimpot clockwise until the corresponding LED starts flashing at a rapid rate. 

Try to set each trimpot at the point where its LED just starts to flash. The free air calibration procedure 

should be performed at reasonable intervals (every 250-500 hours) or whenever a sensor is replaced. If 

you cannot get an LED to rapidly flash when its trimpot is turned full clockwise, you either have a 

damaged sensor or very high hydrocarbon levels in your environment. If both LEDs keep blinking at the 

slow rate, you may have a low battery voltage condition. Try connecting a battery charger. The WEGO 

includes internal diagnostics for abnormal battery voltage (less than 11 volts or greater than 16.5 volts), 

sensor open circuit, and sensor short circuit conditions. A fault condition causes the status LEDs to blink 

at the slow rate.  

 

CAUTION: Racing gasoline containing lead will quickly degrade the sensors. Under these 

conditions, expected sensor life is less than 10 hours. There is no warranty on sensors. 

  

FIRST START – CHECKLIST  

 
 Several items MUST be configured prior to starting the engine:  

 

Install Tuning/Monitoring software and Drivers:  

 

◼ Open PC_LINK_TCFI.exe -- TCFI7 / M8FI Tuning Software.  

◼ Plug the USB cord in between the USB module and the PC.  

◼ Connect the USB module into the four-terminal data-link connector on the WEGO IIID module.  

 

Directory on the PC where the Tuning and Logging software is located at: 

 

C:\Program Files (x86)\Daytona TwinTec\TCFI_Software  

 

Note: 

 
→ M8FI and TFI7 require the use of version 20.4+ of the PC_LINK.exe for tuning and v19.91+ of 

TCFI_LOG.exe logging software. The new software includes storing the options in the tune file and 

ECU. 

 

http://www.daytona-twintec.com/
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To enable communication between the PC, USB module and ECU, the power must be turned on (some 

bikes have an on/off grip switch and a main switch) and the WEGO IIID module must be powered on (red 

LEDs on) and connected to the Front/Rear O2 sensors connectors on the right-hand side of the 

motorcycle.  

Note: The two connectors are grey and black on the Ultra/Touring Models, and both connectors are black 

on the Softail Models. 

 

Verify that the ECU can connect to the PC_LINK Software under Program ECU – Port Setup (Port Setup 

- Communications) verify that the correct COM Port is selected – it is recommended to use the Auto Port 

Scan Option. 

  

1) Program VIN (Setup New ECU -> Edit TCFI or M8FI VIN) - Enter the Vin  

Caution: The body control module (BCM) will not allow starter engagement if the ECM is 

programmed with an incorrect VIN. The speedometer will also display a VIN error message.  

2) Program Odometer (Setup New ECU ->Edit TCFI or M8FI Odometer Setting) – Enter the 

Odometer reading 

Both the ECM and speedometer store accumulated odometer mileage. If you enter a value lower than 

what the speedometer shows, the odometer display will not function correctly until enough mileage is 

accumulated for the ECM to catch up.  

Caution: if you program a higher value, the odometer display will “learn up” to this value.              

If you mistakenly program a very high value, the only solution is for the Harley-Davidson dealer to 

replace the speedometer. If this unfortunate mistake occurs, disconnect and dispose of the 

speedometer BEFORE re-installing the original equipment ECM. If you reinstall the original 

equipment ECM with the speedometer still connected, the ECM will also “learn up” to the 

incorrect odometer mileage and you will have to replace both the ECM and speedometer.  

3) Run the ETC auto-calibration routine (Setup New ECU ->Calibrate ETC System) – follow the 

instructions on the screen, the initial test takes about 45 seconds to complete.  

4) Download the TUNE from the ECU to the PC (Program ECU – Port Setup -> READ ECU…. 

READ ECU TUNE (Bike) → to PC). Be sure to save this on your PC before proceeding (File -> 

Save As).  

5) Adjust the fuel tables based on the size of your fuel injectors vs the factory injector (important).  

If you are using the same BASE PW and your fuel injectors are larger than factory injectors → 

you must reduce/lower the numbers in the main fuel table. Generate your scale factor: old injector 

size / new injector size = scale factor. Multiply the entire Main Fuel table by the scale factor. Open 

the Main Fuel Table -> Click on the TPS/RPM cell to select the entire fuel table and then right 

click and choose the option Modify – enter in the factor 75% for 0.75 or 75 percent – Save the 

table – Save the new tune file with a new name (File -> Save As) and then upload the modified  

 

 

 

 

 

http://www.daytona-twintec.com/
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file to the ECU (Program ECU – Port Setup -> PROGRAM ECU….SEND TUNE → TO ECU  

(Bike)). NOTE: Scaling the Main Fuel Table will only get you close – this software does not have 

injector breakpoint compensation built into it. 

  

Our system is Alfa-N or Pulsewidth based system. The main fuel table is multiplied against a 

MAX Base Fuel Pulse Width Value to generate the pulse width for the fuel injector. This type of 

system is very easy to tune and configure. 

 

For example, if you choose a MAX BASE PW Value of 25ms and your main table is 12 → the 

commanded pulsewidth is 3ms. Note: Your actual value will typically be higher due to other 

adders that are setup to start and run/trim the engine; if all of these adders were set to zero, your 

actual PW will be 3ms. With the default tune that is shipped with the M8 NA ECU → when the  

engine is at 220F, then the rear pulsewidth will be around 3.6ms and the AFR at idle will be 

around 13:1. 

 

Our recommendation is to click the check box: MAX BASE PW AUTO CALC under 

(Edit…Scalars→Edit Basic Parameters). Choosing this checkbox automatically calculates and sets 

the Base Fuel Pulse Width value to the maximum pulse width value that can be utilized at the 

MAX RPM LIMIT Value (Edit…Scalars→Edit Basic Parameters) entered in the tune. We 

recommend setting this value to a high value (slightly higher than the ACTUAL maximum pulse 

width value at the max RPM) –> this is because on heavy tip in events → often times, it is 

possible to for the engine to require a larger value than the maximum pulse width. 

 

The absolute maximum ECU pulse width value is automatically calculated by the ECU based on 

the MAX RPM LIMIT. For example,6000rpm = 20ms. The ECU automatically limits maximum 

pulse width based on the RPM limit value in your tune. When you are logging your engine be sure 

to size your injectors so they run at less than 85% of the maximum pulse width value. 

 

6) Verify that the motorcycle cranks and runs.  

 

After starting the motorcycle – if you have a check engine light – use the TCFI_Log.exe software 

to view the code. Choose View->View Real Time Data and in the upper right-hand corner the  

 

error will be displayed. If the error is a sync error – shut off the engine and wait until the lights on 

the WEGOIIID module go off and then restart the engine. Sync errors occasionally occur – they 

are most likely to occur after changing the tune file.  

 

7)  Adjust the tune based on live data stream or analyzing saved data logs and other engine data 

(wide-band sensor/narrow-band sensor data).  

For reference: typically if an engine pops on acceleration it is LEAN……..when cold---if it won’t     

start it is usually LEAN…….otherwise if it is too rich it blows black smoke ☺.  

 

Utilize the built in wideband sensors and the real time data logging – adjust the tune prior to 

turning on the AUTO-TUNE Feature.  

 

http://www.daytona-twintec.com/
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Typical SAFE Target AFR values -- IDLE: 13.0-13.3 AFR (0.88 λ - 0.9λ)  

 

      Typical SAFE Target AFR values -- CRUISE: 12.5-13.3 AFR (0.85λ - 0.9λ) 

 

Typical SAFE Target AFR values -- WOT NA: 12.0 (0.82λ) WOT Boosted: 11.0 (0.75λ)  

 

8) Read and Clear ECU codes by using your PC and TCFI_Log.exe software. The software uses the 

USB module to connect to the ECU. Use to gather data for tuning and to read/clear ECU codes.      

       

 
ENGINE DIAGNOSTICS  

 
The TCFI7 & M8FI ECU has extensive diagnostics. When the ignition switch is first turned on, the check 

engine LED illuminates. The LED goes out when the system initialization is complete.  

 
If a diagnostic fault is detected while the engine is running, the LED will illuminate. Diagnostic codes can be 

read and cleared by means of the speedometer (same as with the OE ECM) or TCFI Log software. Most of the 

diagnostic codes are the same as those used by H-D and the H-D Electrical Diagnostic Manual for your model 

should be employed as a primary troubleshooting reference. Certain diagnostic codes that are unique to the 

TCFI or require special consideration are listed below:  

 
P0373 CKP Signal Lost. This code will appear if the engine stalls. Customers are often confused 

about the meaning of the term “trips” associated with codes, especially P0373. This is an industry 

standard terminology. If code P0373 shows 40 trips, it means that the code was set 40 engine start 
cycles ago, not that the code has been set 40 times and that the crankshaft position sensor is defective.  

 
P0132 Rear Oxygen Sensor High, P0134 Rear Oxygen Sensor Low/Open, P0152 Front Oxygen 

Sensor High, or P0154 Front Oxygen Sensor Low/Open. These codes indicate a problem with the 

WEGO IIID unit. P0134 and/or P0154 will be set if the WEGO signal connection (white and blue 

wires) or WEGO power is lost. These codes may also be set if a Bosch sensor fails or becomes 

contaminated by leaded gasoline. 

 

Historical diagnostic codes logged by the TCFI unit are listed along with the number of trips (engine start 

cycles) since the individual code was last logged. Codes are automatically cleared after 50 trips.   

 

The meaning of the term “trips”  

This is an industry standard terminology. If a code shows 40 trips, it means that the code was set 40 

engine start cycles ago, not that the code has been set 40 times.  

 

 
 

 

 

http://www.daytona-twintec.com/
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APPENDIX A – TROUBLESHOOTING FLOW CHARTS 

 

FAIL to START TROUBLESHOOTING FLOWCHART 

 

 

http://www.daytona-twintec.com/
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WEGO TROUBLESHOOTING FLOWCHART 

 

 

 

http://www.daytona-twintec.com/
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COMMUNICATIUONS TROUBLESHOOTING FLOWCHART 
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